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Copying
Color Settings

Auto Color: This setting tells your machine to differentiate between color and B&W
originals. B&W originals will be copied and metered in B&W. Color originals will be
copied and metered in color.

Full Color: This setting tells your machine to treat all copies as color copies (not
recommended due to high cost).

Black: This Setting tells your machine to copy ALL ORIGINALS in B&W.

2 Color: This setting will copy the colors present in an original to one color, while
leaving black (i.e. text) the same.

Single Color: This setting will take all color and black from an image and alter it to
a single color.
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Paper Supply
Index Stock paper is recommended by Konica Minolta
All 8/9 Series and E series

227

Tray 1: 500 sheets – Universal

Tray 1: 500 sheets – Up to 8 1/2 x 14

Tray 2: 500 sheets – Universal

Tray 2: 500 sheets - Universal

Tray 3: Various options

Tray 3: Various options

Tray 4: Various options

Tray 4: Various options

Bypass Tray: 150 sheets – Universal

Bypass Tray: 100 sheets - Universal

Either bypass tray can hold up to 10 envelopes at a time.

Paper Thickness:
Plain Paper: 64 -90 g/m2
Thick 1:

91 -120 g/m2

Thick 2:

158 – 209 g/m2

Thick 3:

210 – 256 g/m2

Thick 4:

257-300 g/m2

You cannot duplex Thick 4 paper
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Reducing and Enlarging
To reduce or enlarge a standard size
(8½x11, 8½x14 or 11x17)
1. Place your original in the document feeder.
By default, the MFP will choose the matching paper size.

2. Select the size paper you would like to copy on.
Your MFP will automatically adjust the zoom to the correct percentage.

3. Press [Start] to copy.
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To reduce or enlarge an object off of the glass
1. Place your original face down in the upper left corner of the glass.

2. Select the size paper you want to copy on.

3. Select a preset or select [Zoom].

4. Enter in the percentage you would like to enlarge/reduce to by tapping the box in the
center, followed by your desired percentage.
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5. To avoid wasting paper, you may want to use the [Preview] function.
This function allows you to see your copy on the touch screen before you make your copy.

6. If you are happy with how your reduction/enlargement looks, press [Start] to copy.
If not, select [Cancel] and try a different percentage.
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1-Sided/2-Sided. Choosing Original -> Output
By default, our MFP’S are set to 1-sided originals -> 1-sided copies.
To choose another option, simply tap the desired [Original->Output] setting.
(HINT: The image on the left represents what you have in your hand, your Original(s). The image
on the right represents what your copies will be, your Output.)

Selecting Number of Copies/Number of Sets
To change the number of copies you wish to make select [No. of Sets], then enter your desired
number via the touch-screen keypad.
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Finishing
Finishing options are located on the main screen under the [Finishing] tab.

The FS-534/36 & FS-533 staple up to 50 sheets.
sheets.

The FS-535/37 staples up to 100

w/Booklet/Fold

w/Booklet/Fold

Sort: Sorted sets will place pages in sequential order. 1, 2, 3, 4…
Group: Grouped sets will consist of all page 1’s as a set, all 2’s, all 3’s
Half Fold: You can [Half Fold] 3 sheets at a time of 8 ½ x11, 8 ½ x 14 and 11 x 17 paper.
Center Staple and Fold: [Center Staple and Fold] up to 20 sheets at a time of 8 ½ x11, 8 ½
x 14 and 11 x 17 paper.
Tri-Fold: Fold up to three sheets at time of 8 ½ x 11 landscape orientation only.
Offset: Offsetting your copies will stagger each set by one inch on the finisher when
completed.
Hole Punch: [2-Hole] and [3-Hole] punch are available as options.
Folding: [Half Fold], [Center Staple and Fold] and [Tri-Fold] are available as options.
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Special Application Copying
Book Copying
1 From the main [Copy Screen], select [Application].

2. Scroll and select [Book Original].
3. Select [On]. This feature enables [Non-Image Area Erase] which allows you to keep the
document feeder open. It also enables [Centering], which allows the copier to detect the
center spine of your book.

4. Choose [Separation] to place each page on a separate copy or select or select [Book
Spread] to combine both pages on to a single sheet.
5. Once you have selected your options, press [Ok].
6. Press the [Start] button to begin scanning.
7. At this time, you may scan subsequent pages of your original book by turning to the next
page and pressing [Start] on each new page.
8. Select [Finish], then [Start] when scanning is complete.
12

Booklets

Booklets can be made on 8 ½ x 11, 8 ½ x 14 and 11x17
1. From the default [Copy Screen] select [Application].

2. Scroll and select [Booklet] under the E tab, labeled [Layout].
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3. Select your options and press [Ok].

4. Load your originals in the document feeder in single-sided consecutive order, portrait
orientation.
5. Press Start.
Booklets can be made on 8 ½ x11, 8 ½ x 14 and 11 x 17 paper.

Paper must be loaded in landscape orientation for folding booklets.

Portrait

Landscape
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General Printing Overview
-

Basic printing settings often can be changed from the Print Dialog Box within the software you are
using. The look of the of the Print Dialog Box will vary depending on what software you are printing
from.

-

You can initiate printing by selecting [File – Print] in the upper left-hand corner of your software, or by
using the shortcut [Ctrl+P]. You may also change basic settings such as: Printer, Number of Copies,
Portrait/Landscape and Page Range.
For advanced options, select [Printer Properties]/[Properties].
Options within MS Office include:
1. Print – Select this once ALL OPTIONS have been chosen
2. Number of Copies
1

3. Selectin your desired printer

2

4. Page Range
3

5. Select [Printer Properties] for more options.
4

5
-

One Sided/Two Sided
Portrait Landscape
Paper Size
Margins

Options from an Adobe PDF viewer include:
1. Selecting desired printer
2. Select [Printer Properties] for more
options.

1

3

2

3. Number of Copies

4
4. Page Range
5. Size/Scale Options

5

7

6. Portrait/Landscape
7. Preview
8. Print- Select once ALL OPTIONS have
been Chosen
15
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My Tab
-

Selecting [Printer Preferences] or [Preferences] will take you to the Konica Print Driver. From there, you
can select a multitude of settings depending on your desired print output.
Once you have finished adjusting your options, select [OK]
The driver is separated in to tabs that focus on different areas of functionality. The driver will open to
[My Tab] by default.
From [My Tab], you may select from
settings such as:
1

2

1. Portrait/Landscape
2. Number of Copies

3

4
3. Original Size/Paper Size
4. 1 Sided/2 Sided
5
5. Color/B&W
6

6. [OK] – Click when you are
finished editing options and are
ready to print.

Customizing My Tab

You can customize [My Tab] to suit your needs. To do so, simply navigate to the option you wish to
add to [My Tab]. Right-Click on the option then select either [to the LEFT] or [to the RIGHT]. Your selected
option will then be available in [My Tab].
Right-click on the drop down
arrow next to the option you
wish to add to [My Tab], then
select [to the LEFT] or [to the
RIGHT]
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Basic Tab
The [Basic] tab allows you to change
settings such as:
1. Output Method
Print
Secure Print
User Box

1

2. Zoom

2
3
4

3. Collate/Offset
4. Paper Tray/Paper Type
5

5. [OK] – Click when you are
finished editing all options and
are ready to print.

Layout Tab

The [Layout] tab allows you to
adjust settings such as:

1
2
3

[OK] – Click when
you are finished
editing all options
and are ready to
print.
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-

1. Combination
2 in 1
4 in 1
2. Print Type
1-Sided
2-Sided
Booklet
3. Binding Position
Left
Right
Top
Image Shift/Binding
Margin
Rotate 180 Degrees/Skip
Blank Pages

Finishing Tab

The [Finish] tab allows you set the
following finishing options.
1. Staple
Left
Right
2-Position Left
2-Position Right
2-Position Top
2. Center Staple and Fold

1
1
2
3
4

(Requires additional accessory)

3. Punch (Requires additional accessory)
Two hole (left or right)
Three hole (left or right)
4. Fold (Requires additional accessory)

Available options will vary
depending on your MFD
model and
configuration/accessories.

[OK]
Click when you have finished
selecting all options and are ready
to print.

Cover Mode Tab
The [Cover Mode] tab allows you to select
cover page options. Adding a cover allows
you to add a different Paper Tray/Paper
Type as a front/back cover to your
document.

1

1. Front Cover
Blank or Printed
Source Tray for Cover
2. Back Cover
Blank or Printed
Source Tray for Cover

2

[OK] – Click when you are
finished editing all options and
are ready to print.
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Stamp/Composition Tab
The [Stamp/Composition] Tab allows
you to add:

1

1. Watermark
Print a preset or
custom-made
watermark on your
document.

2

2. Copy Security
A Copy Protection
function that embeds
a pattern that restricts
copying of your
document.

3&4

[OK] – Click when you are
finished editing all options and
are ready to print.

3. Date/Time
4. Page Number

Quality Tab
The [Quality] Tab gives you access to color
and resolution settings.
1. Select Color

2

1

-

Auto Color

Images with color are
printed in color. Images
without color are
printed in gray scale.
- Gray Scale
Prints document in B&W

- Two Color
Black and grey are left
as-is. All colors are
converted to your
chosen color.
2. Resolution

[OK] – Click when you
are finished editing all
options and are ready
to print.
19

Special Application Printing
Printing Envelopes On Your Konica MFD
Settings for Microsoft Word
1. Open Word.

2. Select [File] Print

3. Select [Printer Properties]. Make sure you have selected your Konica MFD.

4. Under the [My Tab] tab, or the [Basic] tab, change the [Paper Type] to [Envelope].
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5. Select [Ok] on the [Properties] tab.
6. Select [Mailings], then select [Envelope] or use [Mail Merge].

7. Enter your desired address information.
NOTE: If you are using an envelope other than COM10, select [Options], then select
the corresponding size envelope.

8. Select [Print] when you are ready.
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MFP Setup for Envelopes
When you walk up to you MFP, you will see this screen.

It must read [Envelope
Com 10, Envelope] here.
If it does not, your envelope will
wrinkle, seal or not print
properly. Return to step 4 of the
Word Setup portion and be sure
to select [Envelope] as the
Paper Type.

1. Load your envelope(s) face down/flap up in the bypass tray.
A MAXIMUM OF 10 ENVELOPES CAN BE LOADED AT A TIME.
Make sure that you slide the lateral guide to fit the envelopes .

2. Once you have loaded your envelopes, the [Complete] option will appear on the screen.
Select [Complete] and your envelope(s) will begin printing. Press [Start] if prompted.
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Printing Tabs on Your Konica MFD
For the Windows Driver
In order to print tabs on your Bizhub MFD you will need to put your tabs in reverse order or purchase
reverse order tabs.
1. Download and open your template.
The templates on this website work well.  https://www.mybinding.com/copier-tab-templates.html

2. Edit your Tabs.
From your templates, you can edit your Tabs by moving your cursor over the text for each tab position,
deleting the template text and entering your own.

3. Select [File -> Print] or [Ctrl ->P] when you have finished editing your tabs.
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4. Select your printer and then select [Printer Properties].

5. Under the [My Tab] tab, change the [Original Size] to [8.5x11 Tab]. When the promt [“Confirm setting
changes…”] appears, select [Yes]. If you do not receive this prompt, go to the [Basic tab] and set the [Paper
Type] to [TAB].

6. Select [OK]. You may now print.
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At the MFD
In order to print tabs on your Bizhub MFD you will need to put your tabs in reverse order or purchase
reverse order tabs.
7. Grab your reverse order tabs and walk up to your MFD. You should see this screen, which prompts you
to load your tabs in the Bypass Tray.

8. Load your reverse order tabs face down and with tabs facing out in the Bypass Tray.

Tab 5 on
bottom

9. When the [Complete] button becomes available, tap it. Your tabs will begin printing.

25

Faxing
To send a fax directly

1. Load the original(s).

2. Select [Scan/Fax].

3. Select a stored One-Touch destination, or press [10 Keypad] to manually enter a number.

.
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3a. To manually enter a destination press the [10Key Pad]. Enter your destination number
exactly as you would dial it.

4. Configure the optional settings for fax as necessary.

5. Press [Start].
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Scanning:
Send an Email directly
1. Load the original(s).

2. Press [Scan/Fax].

3. Select your One-Touch destination.

3a.

If you need to send to an email address that has not been
programmed: Select [Direct Input] then select [Email].
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3a. Enter the desired email address via the keypad.

4. Configure options for your scan if necessary.

5. Press [Start].
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Blank Page Removal
Blank Page Removal allows you to eliminate empty pages when scanning or faxing two-sided
documents.
Note: In order to use this function the [File Type] must be set as a standard PDF.

1. Select your destination.
Make sure the [File Type] is set to PDF.
2. Tap [Application].

3. Tap [Original Settings].
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4. Tap [Blank Page Removal] so that the check box is highlighted.

4. Press [Start].
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Saving Email Addresses and Fax #’s
Saving Addresses and Fax Numbers on 8 and 9
Series MFPs
This process is available for all 8 & 9 Series Bizhub MFP’s.

1.

From the Main Menu, select [Address book].

1. Select [New].

2. Select the [Address Type]. Chose Email, Fax, User Box, etc.
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3. Enter the necessary information for your contact.
1. Name
Enter the contact's name as you would like to appear on the MFP

2. Index/Favorites
Choose under what letter group to place the contact in the Address book (ABC, DEF...). Choose Favorites to have the
contact appear on the main Fax/Scan screen.

3. Email/Fax/User Box etc...
If entering an email, type the contact's full email address. If entering another type of One-Touch (Fax, User Box...) enter
the full number or User Box name here.
*If entering a fax, enter the full number without dashes. Example: 915558675309

Email Example

4. Select Register when you are ready to save your One-Touch destination.
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Saving Fax numbers and Email Addresses on E
Series MFPs
Press [Menu].
Select [Utility].
Select [Create One-Touch Destination].
Select [Address Book].
Select [Email] or [Fax].

1.
2.
3.
4.
5.

Email

Fax

6

6

7

7

8

8

9

6. Enter the name as you would like it to appear on the screen.

To enter a fax
number; highlight
display keypad,
then enter the
number EXACTLY as
you would dial it.

7. Choose how you would like your entry to be indexed ( ABC, DEF, Favorites, Etc...)
8. Enter the full email address or fax number.
9. Select [OK] twice.
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Saving Email Addresses and Fax Numbers (from
your computer)
1. First, obtain the IP address from your copier.
1. Press [Menu].
2. Select [Utility].
3. Select [Device Information]. The IP Address is located on line [IPv4].
2. Open a new web browser window.
Type the IP address into the address bar and press [Enter].
3. Click the orange mailbox or [Store Address] to edit, delete or add [One-Touch
Registrations].

4. Select a [One-Touch] to edit, delete or select [New Registration].
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5. For a [New Registration] choose what type of [One-Touch] you would like to create and
select [OK].

From the above screen you can add email addresses, fax numbers, user boxes etc…

EMAIL EXAMPLE
6. Enter the necessary information and select [OK].
Note: Enter a name, index location (ABC/DEF…). Selecting [Main] will put the contact
on your favorites screen. Enter the corresponding email address and select [OK] to
save your One-Touch destination.
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Secure Print for Confidential Documents
The [Secure Print] function is particularly suitable for safely printing highly confidential documents.
Secure Print allows users to set an ID and Password for print jobs. The print data is then stored in
the Secure Print User Box and can be retrieved by the user with their ID and Password. With the
job not printing until the user retrieves it, confidential documents can be kept secure or prevented
from being discarded.

Secure Print (PC)
1. Within [Properties/Preferences] select the [Basic] tab. Go to [Output Method] and select
[Secure Print].

2. Enter an ID and Password then select [OK]. Select [OK] or [Print] again to send your print
job. The data is saved in the [Secure Print User Box].

Refer to p38 for instructions on how to retrieve your print job at the MFP
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Secure Print (Mac)
Every Mac OS varies slightly. Yours may look different. In Step 1, the objective is to find the Output Method
setting.

1. File Print- Click [Safari] &
select [Output Method].

2. Under [Output Method]
select [Secure Print].

3. Enter the Username and Password
you would like to use for Secure Print.
Select [OK] and select [Print].

Click the box marked [Save
Settings]. This will save your
username and password so
that when you use Secure
Print in the future you will not
have to reenter this
information.

Refer to p38 for instructions on how to retrieve your print job at the MFP
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Retrieving a Secure Print document from the
MFD
1. Press [Menu].
2. Select [User Box].

3. Select [System] – [Secure Print].

4. Enter the document ID and password, and then select [OK].
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5. Highlight a file to print and then select [Print]. Select [Select All] for multiple documents.

6. Set print options if necessary.

7. Press the [Start] key.
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Printing From and Scanning to a USB
To Print from a USB Flash Drive
1. Insert your USB flash drive.

2. Select [Print a document from External Memory].

3. Highlight the file you wish to print and then select [Print].
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4. Select print options if necessary.

5. Press [Start].

6. Once your document has finished printing you may remove your USB.
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To scan to a USB flash drive
1. Load your original.

2. Insert your USB flash drive.

3. Select [Save a document to External Memory].
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4. Choose file save options if necessary.

4. Press [Start].

5. Your file has been saved. You may remove your USB flash drive.

44

User Boxes:
To Create a User Box
User Boxes allow you to save a document on your MFP for printing and sending.
1.
2.
3.
4.
5.
6.
7.
8.

Press [Menu].
Press [Utility].
Select [One Touch/User Box Registration].
Select [Create User Box].
Select [Public] or [Personal User Box].
Select [New].
Input a [User Box Name].
Input a password. Note: ID and password are case sensitive.
Reenter password
If you do not want a password, skip this step.
9. Select [Forward].
10.
Highlight the desired [Auto Document Delete Time].
11.
Select [OK].

Make note of your User Box No., you will need it if you wish to save to your User Box from your
PC.
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To save a document into a User Box (from the
copier)

1. Load the original.
2. Press [Menu].
3. Press [Box/User Box].
4. Specify a [User Box] to save data. If the [User Box] is password protected, select [Open] to
enter the password.

5. Select [Save].
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6. Select save options if necessary.

7. Press the [Start] key. The file is saved.
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To Print or Send a Document from the User Box
1. Press [Menu].
2. Press [User Box].

3. Select desired [User Box] and press [Open].

4. Highlight the document you wish to print/send.
5. Select [Print] or [Send].

6. If sending, select your destination(s) and options.

7. Press [Start].
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To save a document in the User Box (from a PC)
1. Go to [File>Print].
2. Press [Printer Properties].
3. Under [Output Method], select [Save In User Box].

4. Press the [User Settings] button directly underneath the [Output Method]. Give the file a
name you would like it to save as. You will also need to enter your User Box No. from
earlier.

5. Press [OK] twice. You will see your file save to the [User Box].
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Connect With Us

